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Kreiranje prazne baze podataka 
Izabran je primer baze podataka koja služi za praćenje poslovanja jedne firme koja radi sa 
određenom grupom proizvoda i sarađuje sa određenim brojem drugih firmi. 

 Ako okno poslova New File nije vidljivo, otvoriti ga pritiskom na dugme New ( ) na 
Access-ovoj paleti sa alatkama 

 U odeljku New ovog okna poslova, pritisnuti Blank Database  
 Pojaviće se okvir za dijalog File New Database u kome može da se da naziv novoj bazi 

podataka i odredi gde će biti sačuvana 
 Ovoj bazi podataka daćemo naziv Poslovanje 
 Kliknuti na dugme OK 

Nakon toga pojaviće se prozor baze podataka. Može se videti da su liste svih kategorija 
objekata prazne.  

Kreiranje tabele 
Baza podataka Poslovanje će sadržati 4 tabele i to su: 

1. Firme 
2. Proizvodi 
3. Fakture 
4. Detalji_fakture 

Prilikom kreiranja tabela u prikazu Design korisnik sam definiše strukturu tabele, odnosno 
unosi sam nazive polja (zaglavlja kolona), definiše tip podataka za svako polje i 
eventualno unosi opis polja.  
Neophodno je dati naziv svakom polju. Ime treba da bude lako za pamćenje, kao i opisno 
– da se može prepoznati funkcija polja na osnovu imena. Potrebno je da bude dovoljno 
dugačko da omogući opis polja, ali ne i previše dugačko. Access dozvoljava do 64 
karaktera (uključujući prazan prostor) za naziv polja. 
U ovoj vežbi će biti napravljena struktura svih tabela baze podataka Poslovanje. 

Tabela Fakture 
 Na traci sa objektima izabrati kategoriju tabele (kliknuti na dugme Tables) i potom dva 

puta kliknuti na komandu Create table in Design View u okviru sa desne strane.  
Ekran će izgledati ovako: 
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Gornji deo prozora služi za definisanje polja u tabeli. U koloni Field Name unosi se naziv 
polja.U koloni Data Type se određuje tip podataka koji može da se upisuje u to polje 
tabele, a opis polja se unosi u koloni Description. Tip podataka se bira iz padajuće liste. 
Podrazumevani tip podataka je Text. U donjem delu prozora (Field Properties) se mogu 
videti i menjati svojstva trenutno izabranog polja.   

Tipovi podataka 
Nakon određivanja naziva polja neophodno je odlučiti koji tip podataka će to polje sadržati.  
Pregled tipova podataka koji postoje u MS Access-u dat je u sledećoj tabeli: 
 

Tip podatka Opis podatka 
Text Alfanumerički karakteri (slova, znakovi i brojevi); 0-255 karaktera 
Memo Alfanumerički karakteri; 0-65536 karaktera 
Number Numeričke vrednosti 
Date/Time Datum i vreme 
Currency Monetarni (novčani) podaci 
AutoNumber Automatsko uvećavanje brojeva 
Yes/No Logičke vrednosti: da/ne (Yes/No), tačno/netačno (True/False) 
OLE Object Slike, grafikoni, zvuk, video 
Hyperlink Link na internet adresu 
Lookup Wizard Prikazivanje podataka iz druge tabele 

 
Kada se pokazivač postavi u kolonu Data Type i pritisne taster miša pojavljuje se dugme 
sa strelicom usmerenom na dole ( ). Da bi se otvorila padajuća lista sa tipovima 
podataka potrebno je pritisnuti ovo dugme. 
Uneti sledeće podatke za nazive polja i tipove podataka koje polja mogu da sadrže za 
tabelu Fakture datim redosledom (slika koja sledi je za već kreiranu tabelu):  
 

 
 

Ostale karakteristike ove tabele su sledeće: 
Polje Datum ima sledeća svojstva (donji deo prozora – Field Properties): 

1. može se unositi datum do 30 dana unazad – postaviti pravilo provere valjanosti 
(Validation Rule). Pravilo glasi: >=Date()-30 And <=Date() 

2. postaviti tekst koji će se pojavljivati u slučaju da je datum pogrešan (ovo svojstvo se 
zove Validation Text). Taj tekst treba da glasi: Datum koji ste uneli mora biti 
današnji ili neki raniji do 30 dana unazad 

Polje Ulaz-Izlaz ima sledeća svojstva (donji deo prozora – Field Properties): 
1. polje Ulaz-Izlaz se definiše tako da se u njega može uneti samo jedan karakter i to 

"1" za ulaznu fakturu ili "2" za izlaznu fakturu. Pravilo provere valjanosti glasi: ="1" 
Or ="2" 

2. za isto polje uneti tekst koji korisnika obaveštava o pogrešnom unosu: Možete uneti 
"1" kada se radi o ulaznoj fakturi ili "2" kada se radi o izlaznoj fakturi 
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Pravila provere valjanosti služe da obezbede unos samo ispravnih podataka (podataka 
koji zadovoljavaju neke kriterijume) u odgovarajuće polje. 
Da bi se zapamtila struktura tabele potrebno je uraditi sledeće: 

 kliknuti na dugme SaveAs ( ). Nakon toga pojaviće se okvir za dijalog u kome je 
moguće uneti ime tabele: 

 

 
 

 umesto Table1 upisati Fakture i kliknuti na dugme OK 
 nakon ovoga će Access obavestiti korisnika da nije kreiran primarni ključ i pitati ga da li 

želi da ga kreira. Klinuti na dugme No 
 U listi objekata tipa tabele pojaviće se tabela Fakture 

Jako je poželjno da se za svaki kreirani objekat baze podataka unese opis (Description). 
Opis treba da govori o nameni objekta. Opis se može uneti ako se klikne desnim tasterom 
miša na naziv objekta i izabere Propeties u meniju koji se pojavljuje. 
Samostalna vežba. Kreirati sledeće tabele u bazi Poslovanje koje su definisane na 
sledeći nači: 

1. tabela Firme 
 

 
 

2. tabela Proizvodi 
 

 
 

Svako polje ima svojstva i ona su različita za različite tipove podataka u poljima. Sledi lista 
svih opštih svojstava koja se mogu nalaziti na kartici General (postoji mogućnost da u 
konkretnom slučaju ne budu sva prikazana i to zavisi od tipa podataka u polju): 

• Field Size – Veličina polja. Za tip podataka Text limitira veličinu polja na određeni 
broj karaktera (1-255). Podrazumevana vrednost za ovaj tip podataka je 50. Za tip 
podataka Number se ovde iz padajuće liste može izabrati jedna od ponuđenih 
opcija (celi brojevi, decimalni brojevi, itd.). 

• Format – Menja se način na koji se podaci pojavljuju nakon unošenja (velika slova, 
datumi, itd.) 
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• Input Mask – Koristi se za unos podataka u unapred definisanom i valjanom 
formatu (telefonski brojevi, poštanski brojevi, datumi, itd.) 

• Decimal Places – Definiše broj decimalnih mesta. Pojavljuje se samo za tipove 
podataka Number i Currency. 

• Caption – Opciona labela za polja obrazaca i izveštaja (zamenjuje naziv polja) 
• Default Value – Vrednost koja se automatski unosi za nove zapise u datom polju 
• Validation Rule – Pravilo provere valjanosti. Proverava valjanost unetih podataka 

bazirano na pravilima formiranim pomoću izraza ili makroa. 
• Validation Text – Poruka koja se pojavljuje kada uneti podatak ne zadovolji pravilo 

provere valjanosti 
• Required – Definiše da li je neophodno uneti vrednost u dato polje prilikom 

dodavanja novih zapisa 
• Allow Zero Lenght – Određuje da li se može uneti vrednost " " u polje sa 

tekstualnim tipom podataka da bi se vrednost razlikovala od nulte vrednosti 
• Indexed – Ovim se ubrzava pristup podacima i, ako se želi, limitira unos vrednosti 

na jedinstvene 
• Unicode Compression – Koristi se za višejezične aplikacije. Zahteva duplo više 

prostora za smeštanje ali omogućava da Office dokumenti, uključujući i izveštaje 
Access-a budu prikazani korektno bez obzira koji jezik ili simbole koji se koriste. 

• Smart Tags – Služi da se prepozna format unetih podataka i automatski ponudi 
njihovo smeštanje u drugi odgovarajući program koji radi sa tom vrstom podataka 
(na primer, nakon unosa e-mail adrese će biti ponuđeno da se zapamti u adresaru 
Microsoft Outlook-a) 

Unos podataka 
Pošto je zapamćena struktura tabele, sada je neophodno uneti podatke. Unos podataka 
se vrši na sledeći način: 

 Otvori se željena tabela 
 Postavi se tačka umetanja u željeno polje i ukuca podatak. Prelazak iz polja u polje je 

moguće ostvariti pritiskom na taster Tab na tastaturi. Kada se unese podatak u 
poslednje polje, pritiskom na taster Tab se kreira novi zapis u tabeli. Na ovaj način je 
moguće uneti onoliko zapisa koliko se želi. 

 Prelaskom iz jednog polja u drugo, automatski se pamti podatak koji je unesen 
 Kada se završi unos podataka zatvori se tabela ( ) 
 Ponovnim otvaranjem tabele mogu se dodati novi podaci ili izmeniti postojeći 

jednostavnim prekucavanjem starog sadržaja, ili obrisati postojeći 

Primarni ključ 
Svaka tabela mora da ima primarni ključ – jedno ili više polja čiji su sadržaji jedinstveni 
za svaki zapis. Ovaj ključ je način da se obezbedi da zapisi tabele sadrže samo jednu 
jedinstvenu vrednost. U nekim slučajevima je dovoljno identifikovati neko postojeće polje 
pod uslovom da postoji sigurnost da će za svaki zapis u tabeli imati drugačiju vrednost u 
tom polju. Primer je recimo JMBG (Jedinstveni Matični Broj Građana). Ovo je takozvani 
prirodni primarni ključ. 
Postavljanje primarnog ključa može da se uradi na sledeći način: 

 Otvoriti tabelu u Design prikazu 
 Pozicionirati se na željeno polje i pritisnuti desni taster miša 
 Iz menija izabrati Primary Key 
 Polje koje je primarni ključ imaće malu sliku ključa sa leve strane ( ) 
 Da bi se uklonio primarni ključ potrebno je ponoviti ove korake 
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Ako u tabeli ne postoji polje koje bi moglo biti prirodni primarni ključ mora da se doda 
posebno polje koje će imati ulogu primarnog ključa. U ovom slučaju govorimo o veštačkom 
primarnom ključu. Po kreiranju tabele (prvi put kada se želi da se zapamti kreirana tabela), 
ako nije definisan primarni ključ, Access će pitati korisnika da li želi da kreira takvo polje 
kao prvo polje u tabeli. 
Po automatizmu to polje će dobiti naziv ID i biće tipa podataka AutoNumber. S obzirom da 
ovo polje nema drugu svrhu, ono će se automatski popunjavati svaki put kada se doda 
novi zapis u tabelu. 
Samostalna vežba. Kreirati preostalu tabelu u bazi Poslovanje. Obratiti pažnju da ova 
tabela ima primarni ključ nad poljem ID koje je AutoNumber tipa. 

1. tabela Detalji_fakture 
 

 
 

Polja Kolicina i Dan_cena su formata Fixed sa dva decimalna mesta. 

Primarni i strani ključ 
Primarni ključ (PRIMARY KEY) garantuje jedinstvenost zapisa u tabeli. Može se sastojati 
od jednog ili više polja (kolona, atributa). Niti jedno polje koje je deo primarnog ključa ne 
sme sadržati NULL vrednost! Na ovaj način se postavlja ograničenje nad tabelom. To 
znači da se upisom novog zapisa u polje koje je primarni ključ ne sme upisati vrednost 
koja već postoji.  
Strani ključ (FOREIGN KEY) je skup polja (jedno ili više polja) iz jedne tabele (sekundarna 
tabela) čije vrednosti u kolonama moraju da se 'slažu', odnosno da odgovaraju 
vrednostima primarnog ključa u nekoj drugoj tabeli (referentna ili primarna tabela). Može 
sadržati bilo koju vrednost koja je jednaka primarnom ključu iz tabele na koju je 
referenciran. 
Najčešći je slučaj da primarni ključ tabele za koju znamo da će biti referencirana bude 
sačinjen od jednog polja. Ako to nije moguće na osnovu polja koja postoje onda se dodaje 
jedno novo polje koje će imati tu ulogu. 
Polje koje je strani ključ mora imati isti tip podataka i veličinu polja kao polje koje je 
primarni ključ u referentnoj tabeli. Nije neophodno da polje koje je primarni ključ i polje koje 
je strani ključ imaju iste nazive. Definisanjem stranog ključa se u stvari uspostavlja relacija 
između tabela. 
Na sledećoj slici je prikazan primer tabela koje bi trebalo da budu povezane preko stranog 
ključa. Polje Faktura iz tabele Detalji_fakture može uzimati samo one vrednosti koje se 
pojavljuje u polju Sifra_fakture tabele Fakture. 
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Strani ključ je neka vrsta ograničenja nad sekundarnom tabelom, jer dozvoljava da se u 
polje stranog ključa unesu samo podaci koji postoje u polju primarnog ključa u referentnoj 
tabeli. 

Relacije i tipovi relacija 
Baza podataka je sastavljena od različitih tabela, ali te tabele čine jednu celinu i podaci 
koji su zapamćeni u tim tabelama su logički povezani. 
Kada, na primer, čovek otvori račun u banci onda se zapamte njegovi osnovni podaci, ime, 
prezime, adresa itd. Kada sledeći put dođe u banku da podigne novac, njegovi podaci ne 
treba ponovo da se unose, nego se iskoriste postojeći i izvrši novčana transakcija. To je i 
osnovni koncept u relacionim bazama podataka. Tabele u bazi su povezane, odnosno 
nalaze se u nekoj relaciji tako da je moguća razmena informacija između tabela. 
U Access-u je relacije između tabela moguće uspostaviti na dva mesta – (1) u prozoru 
Relationships gde će biti uspostavljene na nivou tabela i (2) kada se prave upiti da bi se 
prikazale informacije iz više tabela i u tom slučaju govrimo o uspostavljanju relacija na 
nivou upita. 
Relacije uspostavljene na nivou tabela se pamte u bazi i automatski će biti prepoznate i 
uspostavljene kada se formira upit nad više tabela. Takve relacije imaju prvenstvo nad 
onima koje su uspostavljene na nivou upita. 
Postoje 3 tipa relacija: 

1. jedan-prema-jedan (1:1) 
2. jedan-prema-više (1:N) 
3. više-prema-više (N:N) 

 
Relacija jedan-prema-jedan 
Relacija jedan-prema-jedan, iako retko korišćena u sistemima za rad sa bazama 
podataka, može biti veoma korisna kao način da se dve tabele povežu. 
Dobar primer relacije jedan-prema-jedan se javlja kod većine sistema za naplaćivanje; 
tabela za naplatu se formira da bi se obezbedile dodatne informacije neophodne za 
fakturisanje kupaca na lokaciji koja nije njihova uobičajena adresa. Ova tabela obično 
sadrži broj kupca i skup polja za adresu.  
Samo nekolicina kupaca će imati zasebnu adresu za naplaćivanje, pa se taj podatak neće 
dodavati u glavnu tabelu kupaca. Relacija jedan-prema-jedan između tabele kupaca i 
tabele naplaćivanja se može uspostaviti da bi se obezbedila adresa za naplaćivanje za 
one kupce koji žele da imaju zasebnu adresu za naplaćivanje. Iako se sve informacije iz 
jedne tabele mogu dodati drugoj, tabele se drže odvojene zbog efikasnog korišćenja 
prostora. 
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Generalno, relacija jedan-prema-jedan se može iskoristiti i da bi se jedna velika tabela 
podelila na dve manje tabele. Kod relacije jedan-prema-jedan najčešće se primarni ključ 
jedne tabele povezuje sa primarnim ključem druge tabele. 
 
Relacija jedan-prema-više 
Relacija jedan-prema-više se koristi da se jedan zapis primarne tabele poveže sa više 
zapisa sekundarne tabele. Ovo povezivanje se praktično vrši definisanjem stranog ključa 
sekundarne tabele. 
Primer. Tabela Fakture i tabela Detalji_fakture su vezane ovakvom relacijom. Jedna 
faktura može imati više stavki, ali jedna stavka se može naći na samo jednoj fakturi. 
 
Relacija više-prema-više 
Relacija više-prema-više je najteža za razumevanje. To je slučaj kada jednom zapisu iz 
primarne tabele (A) odgovra više zapisa iz sekundarne (B) i obrnuto. Ova vrsta relacije je 
moguća jedino uvođenjem treće tabele koja sadrži najmanje dva polja koja su strani 
ključevi iz tabela A i B. Ova dva polja se mogu iskoristi i za kreiranje primarnog ključa treće 
tabele, mada to nije obaveza. 
Relacija više-prema-više u stvari predstavlja dve jedan-prema-više relacije, tabela A i B sa 
trećom tabelom. 
Primer. Tabela Fakture i tabela Proizvodi su u više-prema-više relaciji. Ta relacija je 
uspostavljena preko tabele Detalji_fakture sa kojom su obe tabele povezane jedan-prema-
više relacijom. Jedan proizvod se može naći na više faktura i svaka faktura može sadržati 
više proizvoda. 

Kreiranje relacije 
Da bi izbegli dupliciranje informacija ponavljanjem istih polja u više tabela, moguće je 
uspostaviti relaciju između tabela i na taj način povezati polja. 
Postupak uspostavljanja relacija između tabela biće prikazan na primeru baze podataka 
Poslovanje. 

 Otvoriti bazu podataka Poslovanje 
 Na paleti alatki klinkuti na dugme Relationships ( ) 
 Iz prozora Show Table koji se pojavljuje izabrati tabele nad kojima se želi da se 

uspostave relacije. U našem slučaju biće izabrane tabele Fakture i Detalji_fakture. 
Tabele se dodaju dvostrukim klikom na naziv tabele ili obeležavanjem tabele i pritiskom 
na dugme Add. 

 

 
 

Ako se prozor Show Table ne pojavi u trenutku kada se otvori prozor Relationships, tada 
on može da se otvori klikom na dugme Show Table na paleti alatki ili desnim klikom miša 
u prozoru Relationships i potom izborom opcije Show Table. 
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 Da bi se povezala polja iz dve tabele, treba kliknuti na polje iz jedne tabele (polje Sifra 
fakture tabele Fakture) i držeći pritisnut taster miša prevući ga na odgovarajuće polje u 
drugoj tabeli (polje Faktura tabele Detalji_fakture). Nakon otpuštanja tastera miša 
pojaviće se prozor Edit Relationships. 

 

 
 

 U ovom prozoru se izaberu druga polja ukoliko je to potrebno (ako su bila povezana 
pogrešna polja) i izabere se opcija Enforce Referential Integrity (ako je potrebno). 
Referencijalni integritet znači da se u strani ključ ne može upisati podatak koji ne 
postoji u primarnom ključu primarne tabele. Takođe, nije moguće obrisati zapis iz 
primarne tabele ako za odgovarajuću vrednost postoji strani ključ u sekundarnoj tabeli, 
niti promeniti vrednost primarnog ključa. Da bi se kreirala ovakva relacija treba kliknuti 
na dugme Create. 

Nakon ovoga pojaviće se linija koja spaja dva polja 
 

 
 
Kada su tabele povezane, jedna se obično zove roditelj a druga (koja je na nju povezana) 
se obično zove dete. Ovo je poznato kao roditelj-dete relacija između tabela. Referencijalni 
integritet garantuje da nikada neće postojati siroče, odnosno zapis u dete tabeli koji nema 
povezani zapis u roditelj tabeli. 
Može se desiti da nakon izbora ove opcije i pritiska na Create dugme (ili OK dugme ako je 
dijalog prozor Edit Relationships naknadno otvoren radi vršenja izmena) Access ne 
dozvoljava formiranje relacije i primenu referencijalnog integriteta. Razlog je verovatno taj 
da se od Access-a traži da formira relaciju i primeni referencijalni integritet između dve 
tabele koje sadrže zapise koji narušavaju pravila referencijalnog integriteta, kao što je dete 
tabela koja sadrži zapise siročiće. Nakon pritiska na dugme OK na prozoru upozorenja koji 
se je pojavio, ponovo se otvara dijalog prozor Edit Relationships gde je sada potrebno 
odčekirati opciju kojom se primenjuje referencijalni integritet i onda uspostaviti relaciju. 
Nakon toga je moguće ukloniti zapise siročiće i uspostaviti relaciju uz primenu 
referencijalnog integriteta. 
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Postojanje udovica zapisa (zapisi u primarnoj tabeli koji nemaju zapise sa kojima su 
povezani u sekundarnoj tabeli) ne narušava referencijalni integritet. 
 
Biranje opcije Cascade Update Related Fields (kaskadno update-ovanje povezanih 
polja) 
Ova opcija se javlja na dijalog prozoru Edit Relationships ako je izabrana opcija Enforce 
Referential Integrity. Ova opcija kaže Access-u da korisnik može da menja sadržaj 
povezanog polja (polje koje je primarni ključ u primarnoj tabeli). 
Kada korisnik promeni vrednosti u polju koje je primarni ključ primarne tabele Access 
utvrđuje da li su i nakon promene u tom polju sve vrednosti jedinstvene i onda prolazi kroz 
povezane zapise u drugoj tabeli i menja vrednosti u polju koje je strani ključ sa starih na 
nove.  
Ako ova opcija nije selektovana ne može se menjati vrednost primarnog ključa u primarnoj 
tabeli ako se on koristi za uspostavljanje relacije sa nekom drugom tabelom. 
Ako se primarni ključ neke tabele koristi za uspostavljanje relacija sa većim brojem tabela 
ova opcija mora biti čekirana za sve povezane tabele jer u suprotnom neće funkcionisati. 
 
Biranje opcije Cascade Delete Related Records (kaskadno brisanje povezanih 
zapisa) 
I ova opcija se javlja na dijalog prozoru Edit Relationships ako je izabrana opcija Enforce 
Referential Integrity. Izborom ove opcije kaže se Access -u da izvrši brisanje svih 
povezanih zapisa u sekundarnoj tabeli kada korisnik obriše zapis sa kojim su oni povezani 
u primarnoj tabeli. Drugim rečima, ako je izabrana ova opcija, brisanjem roditelj zapisa 
brušu se svi deca zapisi. 
Ovo može biti veoma korisno za brisanje niza povezanih zapisa.  
Ako se ne izabere ova opcija Access neće omogućiti korisniku da obriše zapis koji ima 
zapise sa kojima je povezan u drugoj tabeli.  
Da bi se koristila ova opcija potrebno ju je čekirati za sve relacije koje primarna tabela ima 
u bazi podataka.  
Ovu opciju treba koristiti sa oprezom obzirom da ne postoji nikakvo upozorenje niti zahtev 
potvrde od korisnika u vezi brisanja. 
Dijalog prozor Edit Relationships se može otvoriti naknadno izborom željene relacije, 
desnim klikom na izabranu relaciju i izborom opcije Edit Relationship ... u meniju koji se 
pojavljuje. 

 Datasheet prikaz primarne tabele će imati indikator (+) pomoću koga se mogu videti 
podaci koji odgovaraju vrednostima primarnog ključa u sekundarnoj tabeli. Da bi se 
proširile sve vrste odjednom izabrati Format → Subdatasheet → Expand All iz 
glavnog menija. 
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Snimanje relacija između tabela 
Najlakši način da se snime uspostavljene relacije između tabela je da se pritisne dugme 
Save na paleti alatki Access -a. Drugi način je da se zatvori prozor Relationships i 
odgovori sa Yes na pitanje u dijalog prozoru Save Relationships koji se pojavljuje. 

Dodavanje novih relacija 
Pritiskom na dugme Relationships na paleti alatki Access-a se mogu naknadno dodati 
nove tabele i uspostaviti nove relacije. Naravno, ako postoje podaci u novododatim 
tabelama koji narušavaju referencijalni integritet, neophodno je ukloniti sporne zapise i 
zatim primeniti referencijalni integritet. 
Dodati preostale relacije u bazi Poslovanje: 
 

 
 

 Na paleti alatki klinkuti na dugme Relationships ( ) 
 S obzirom da je jedna relacija već uspostavljena, neće se otvoriti Show Table dijalog, 

nego je neophodno otvoriti ga klikom na desni taster miša i izborom opcije Show Table 
 

 
 

 Iz liste tabela dodati i preostale dve table: Firme i Proizvodi 
Za uspostavljanje relacije između tabela Fakture i Firme potrebno je uraditi sledeće: 

 Kliknuti na polje Firma iz tabele Firme i i ne otpuštajući taster miša prevući to polje do 
polja Sifra firme tabele Fakture. 

 Postaviti opcije koje forsiraju referencijalni integritet 
Za uspostavljanje relacije između tabela Proizvodi i Detalji_fakture potrebno je povezati 
polje Maticni broj iz tabele Proizvodi sa poljem Proizvod iz tabele Detalji_fakture i 
uspostaviti referencijalni integritet. 

Brisanje postojeće relacije 
Da bi se obrisala postojeća relacija potrebno je otvoriti prozor Relationships, kliknuti 
desnim tasterom miša na liniju koja predstavlja relaciju i izabrati Delete iz shortcut menija. 
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Linije koje povezuju tabele u prozoru Relationships 
Kada se uspostavi relacija između dve tabele Access automatski kreira tanku liniju koja 
spaja zajednička polja te dve tabele. 
Ako se izabere opcija Enforce Referential Integrity Access menja izgled linije. Ona 
postaje deblja na svakom kraju (uz svaku od tabela). Linija takođe ima ili znak 1 ili znak za 
beskonačno (∞) iznad podebljanog dela na svakoj strani. Znak 1 se nalazi uz tabelu koja 
je roditelj, odnosno uz onu tabelu kod koje je polje primarni ključ, a znak beskonačno (∞) 
se nalazi uz dete tabelu. Na ovaj način je označena relacija jedan-prema-više. 

Štampanje izveštaja o relacijama 
Kada se uspostave relacije između svih tabela moguće je napraviti grafički izveštaj o 
relacijama između tabela izborom File → Print Relationships ... iz menija Access-a dok 
je otvoren prozor Relationships. 

Sortiranje i filtriranje 
Sortiranje i filtriranje omogućava da se vidi sadržaj tabele na drugačiji način 
preuređivanjem podataka ili izdvajanjem podataka koji zadovoljavaju određeni kriterijum. 

Sortiranje  
Može se pojaviti potreba da podaci u tabeli budu poređani u redosledu koji je drugačiji od 
uobičajenog, na primer, da budu uređeni rastuće po datumu. 
Podaci u tabeli mogu da se sortiraju u rastućem ili opadajućem redosledu, po vrednostima 
u jednom ili više polja u tabeli. 
Biće sortirana tabela Proizvodi iz baze Poslovanje po polju Ime: 

 Otvoriti bazu podataka Poslovanje 
 Otvoriti tabelu Proizvodi  
 Da bi se izvršilo sortiranje po polju Ime pozicionirati se bilo gde unutar kolone Ime i 

zatim pritisnuti dugme Sort Ascending ( ) na paleti alatki. Zapisi će biti sortirani po 
imenima proizvoda i to u rastućem redosledu, odnosno po abecedi.  

 Da bi se obrnuo redosled sortiranja, dok se tačka umetanja još uvek nalazi u koloni 

Ime, pritisnuti dugme Sort Descending( ). 
Do komandi Sort Ascending ili Sort Descending je moguće doći i preko menija tako što se 
izabere Records, pa zatim Sorting. Takođe, može da se pritisne desnim tasterom miša u 
koloni sa podacima i izabere željena komanda u meniju koji se pojavljuje.  
Moguće je sortirati po više polja. Pri tom polja po kojima se želi da se izvrši sortiranje 
moraju biti susedna i moraju biti uređena po redu u kome se želi da se sortiraju. Potrebno 
je označiti ta polja i primeniti jednu od komandi sortiranja. Sortiranje će se vršiti s leva na 
desno i sve kolone će biti sortirane na isti način, odnosno ili u opadajućem ili rastućem 
redosledu. 

Filtriranje 
Filtri se koriste kada se želi da se pronađu svi zapisi koji sadrže iste podatke u jednom ili 
više polja tabele (na primer, pronalaženje svih faktura jedne firme ili svih ulaznih faktura za 
određeni datum). 
Postoje dva načina filtriranja:  

1. filtriranje na osnovu selekcije 
2. filtriranje na osnovu obrasca 
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Filtriranje na osnovu selekcije ( ) 
Ovim filtrom će biti izdvojeni svi zapisi koji u određenom polju sadrže vrednost koja je ista 
kao selektovana vrednost u tom polju. 
Da bi se videlo kako radi ovaj filtar, probaće se da se izdvoje svi zapisi iz tabele Fakture 
koji odgovaraju jednoj firmi. To će biti urađeno na sledeći način: 

 Otvoriti tabelu Fakture 
 Postaviti kursor u polje Sifra firme i to u ćeliju koja sadrži šifru firme čije fakture se traže 
 Kliknuti na dugme Filter By Selection ( ) koje se nalazi na paleti alatki 

 

 

Filtriranje na osnovu obrazca ( ) 
Ako je tabela prevelika i veoma je teško pronaći zapis koji sadrži vrednost po kojoj se želi 
da se vrši filtriranje onda se koristi filtriranje na osnovu obrasca. 
Ovaj način formira praznu tabelu koja je po strukturi identična polaznoj tabeli. Polja u ovoj 
tabeli su padajuće liste koje sadrže sve moguće različite vrednosti koje postoje u toj tabeli 
za to polje (kolonu). U ovakvom slučaju je mnogo jednostavnije da se pronađe vrednost po 
kojoj se želi da se vrši filtriranje. 
Ovaj način filtriranja biće pokazan na primeru pronalaženja svih ulaznih faktura za 
određeni datum. Potrebno je uraditi sledeće: 

 Otvoriti tabelu Fakture. Kliknuti na dugme Filter By Form ( ) na paleti alatki 
 Da bi se izdvojile samo ulazne fakture iz padajuće liste polja Ulaz-Izlaz izabrati "1" 
 Iz padajuće liste polja Datum izabrati željeni datum 

 

 
 

 Nakon postavljanja kriterijuma, kliknuti na dugme  (Apply Filter) na paleti sa 
alatkama i prikazaće se zapisi koji odgovaraju postavljenim kriterijumima 

Takođe je moguće postaviti i alternativne kriterijume klikom na Or karticu u donjem levom 
uglu prozora. 
Samostalna vežba. Alternativni kriterijumi – Na primer, da se izdvoje fakture za dva dana. 
U bilo kojoj varijanti filtriranja, zapisi koji ne zadovoljavaju uslov filtriranja se ne gube iz 
tabele, već se samo ne prikazuju. 
Filtrirani sadžaj je moguće zapamtiti kao upit na sledeći način: 

 Pošto se prikaže sadržaj iz menija se izabere opcija File → Save As Query 
 Upiše se naziv upita i klikne na dugme OK 
 Upit je sada zapamćen unutar baze 
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Da bi se uklonio filtar treba kliknuti na dugme Remove Filter ( ) na paleti alatki. 

Upiti 
Upiti izdvajaju zapise iz jedne ili više tabela, po nekom kriterijumu, tako da oni mogu da se 
pregledaju, analiziraju i sortiraju. Rezultat upita je neka vrsta tabele koja se zove dynaset 
(skraćeno od dynamic subset, odnosno dinamički podskup). Sadržaj upita će se promeniti 
svaki put kada se promene podaci u tabelama. Upiti su objekti baze i kao takvi se mogu 
zapamtiti, pri čemu se ne pamte podaci nego se pamti zakonitost po kojoj se zapisi 
izdvajaju, odnosno pravila za izvršavanje upita. U tom smislu, potrebno je izvršiti upit da bi 
se videli podaci koji zadovoljavaju postavljene kriterijume.  
Za izvršavanje upita koristi se standardni jezik za upite koji se naziva SQL (Structured 
Query Language). 
Access je razvio vizuelni alat za pravljenje upita. Ali iza svakog vizuelno napravljenog upita 
stoji upit pisan u SQL-u, odnosno moguće je videti upit u grafičkom prikazu ili njegov SQL 
ekvivalent. 

Alat za vizuelno kreiranje upita 
Biće napravljen upit koji izdvaja sva polja i sve zapise iz tabele Proizvodi baze podataka 
Poslovanje. 

 Otvoriti bazu podataka Poslovanje 
 Na traci sa objektima izabrati Queries 
 Kliknuti na dugme New ( ) na paleti alatki prozora baze podataka 

 

 
 

 Izabrati Design View i potom kliknuti na dugme OK 
 Iz liste tabela izabrati tabelu Proizvodi dvostrukim klikom (ako bi se želelo da se u upitu 

koristi više tabela sve one bi bile dodate u ovom koraku) 
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 Kliknuti na dugme Close 
 Dodati polja tabele koja se žele da budu prikazana u rezultatima upita dvostrukim 

klikom na naziv polja ili prevlačenjem naziva polja u rešetku za projektovanje upita 
(donji deo prozora Design prikaza upita)  

Napomena 1: Izbor polja za prikazivanje se može uraditi i selekcijom iz Field i Table 
padajućih listi u rešetki za projektovanje upita 
Napomena 2: * u listi polja označava sva polja tabele 

 Kada ja napravljen upit može se izvršiti pritiskom na Run ( ) dugme na paleti alatki 
Access-a. Kao rezultat izvršenja upita, u konkretnom slučaju, dobiće se sadržaj tabele 
Proizvodi. 

Prelazak na Datasheet prikaz takođe predstavlja izvršenje upita. 
Da bi se ponovo prešlo u Design prikaz upita treba pritisnuti dugme Design ( ) na paleti 
alatki prozora baze podataka. Ovaj način rada se koristi za pravljenje novih upita kao i za 
izmenu postojećih. 
 

 
 

SQL prikaz prikazuje SQL reprezentaciju upita. Do ovog načina prikaza se dolazi iz Design 
prikaza ili Datasheet prikaza klikom na desni taster miša i izborom opcije SQL View ili 
izborom iste opcije preko dugmeta View na paleti alatki Access-a (strelica desno od 
dugmeta). 
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Nakon ovoga upit se može zapamtiti ako se želi. Ukoliko se klikne na dugme  Access će 
pitati da li se želi da se zapamti upit i pojaviće se okvir za dijalog u kome može da se upiše 
ime koje se želi da se da novom upitu: 
 

 
 

Upisati ime upita i videće se da će se ovaj upit pojaviti u listi objekata kategorije upita. 
Nakon pamćenja upita, kasnije ga je moguće izršavati Run ( ) komandom. Ukoliko neki 
upit više nije potreban, može se obrisati korišćenjem komande za brisanje Delete ( ). 

Osnovna sintaksa SELECT upita 
SELECT lista_polja  
FROM lista_tabela  
WHERE uslov_traženja 
GROUP BY lista_polja_za_grupisanje 
HAVING uslov_traženja 
ORDER BY lista_polja_uređenja 
 
lista_polja − definiše polja koja se izdvajaju 
lista_tabela − definiše tabele iz kojih se izdvajaju podaci 
uslov_traženja − uslov koji treba da zadovolje vrste (zapisi)  
lista_polja_za_grupisanje − lista polja po kojima se vrši grupisanje rezultata 
lista_polja_uređenja − polja po kojima se vrši uređenje rezultata 
 
WHERE, GROUP BY, HAVING i ORDER BY nazivaju se klauzule SELECT upita. 
Poljima i tabelama se mogu davati alijasi. Alijasi polja su u stvari novi nazivi koji se koriste 
prilikom prikazivanja rezultata upita. Tabelama se daju alijasi radi lakšeg referenciranja u 
samom upitu. 

Kreiranje osnovnih upita 
SQL upit je upit koji je načinjen pomoću SQL (Structured Query Language) iskaza. SQL 
upiti se mogu koristiti za pretraživanje, ažuriranje i upravljanje relacionim bazama 
podataka. Kada se napravi upit Access automatski konstruiše ekvivalentni SQL iskaz u 
pozadini. Korisnik može pregledati ili modifikovati SQL iskaz u SQL prikazu. Naravno, 
nakon modifikovanja upita u SQL prikazu sam upit više neće izgledati isto u prikazu 
Design. 

Upiti tipa projekcija 
Pod upitima tipa projekcija podrazumevaju se upiti koji izdvajaju samo neka polja iz tabele, 
pri čemu su prikazane vrednosti iz svih vrsta. 
Da bi se kreirao jednostavan upit koristeći SQL prikaz potrebno je uraditi sledeće: 

 otvoriti bazu podataka Poslovanje 
 na traci sa objektima izabrati kategoriju Queries 
 iz glavnog menija izabrati Insert → Query 
 na New Query okviru za dijalog izabrati Design View i kliknuti na dugme OK 
 kada se pojavi Show Table okvir za dijalog izabrati tabelu Proizvodi i kliknuti na dugme 

Close  
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 dvostrukim klikom prebaciti polje Ime u rešetku za projektovanje  
 iz glavnog menija izabrati View → SQL View. Pojaviće se prozor koji liči na prozor 

programa Notepad: 
 

 
 

 da bi ste izvršio upit kliknuti na dugme Run ( ) na paleti alatki Access-a 
Nakon pregleda rezultata upita vratiti se u SQL prikaz upita. 
Ovde su bila prikazana imena svih proizvoda iz tabele Proizvodi. Ukoliko se želi da se 
prikažu još neka polja onda se to može uraditi na sledeći način: 
Nakon povratka u SQL prikaz ukucati sledeće 

 SELECT Proizvodi.Ime, Proizvodi.Maticni_broj, Proizvodi.Jed_mere FROM 
Proizvodi 

 izvršiti upit pritiskom na dugme Run ( ) 
 

 

 
 zapamtiti upit pod proizvoljnim nazivom 

Samostalna vežba. Izvršiti sledeći upit: 
SELECT * FROM Firme 

Upiti tipa selekcija 
Filtriranje na osnovu selekcije u SQL-u se može izvršiti korišćenjem WHERE kluzule, kao 
na primer: 

SELECT * FROM Firme WHERE Mesto = "Niš" 
Na ovaj način se izdvajaju samo one firme koji su iz Niša. 
Access i za ovu vrstu upita ima svoj ekvivalent u grafičkom načinu rada.  

 Otvoriti bazu ako nije već otovrena 
 Na traci sa objektima izaberati kategoriju Queries 
 Dvaput brzo kliknuti levim tasterom miša na komandnu ikonu Create query in Design 

view 
 Iz liste tabela izabrati tabelu Firme i potom pritisnuti na dugme Close 
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 U listi polja tabele Firme izabrati Firma, Naziv_firme, Mesto i Telefon 
 Da bi se prikazale samo firme iz Niša pozicionirati se u kolonu Mesto u ćeliju koja 

pripada redu Criteria i u tu ćeliju ukucati Niš i pritisnuti taster Enter  
 

 
 

 Izvšiti upit 
 Ponovo preći u Design prikaz 

S obzirom da se zna da se izdvajaju samo firme iz Niša, nema potrebe da se prikazuje 
kolona (polje) koja sadrži taj podatak tako da može da se odčekira opcija Show za 
kolonu Mesto 

 da bi se video odgovarjući SQL upit kliknuti desnim tasterom miša u praznu oblast 
prozora i izabrati SQL View 

 

 
 

 izvršiti upit 
 zatvoriti upit. Na pitanje da li se želi da se zapamti upit, kliknuti na dugme Yes i ukucati 

Firme iz Nisa kao ime upita i pritisnuti taster Enter 
Samostalna vežba. Napraviti upit koji prikazuje količinu, cenu i iznos za svaku stavku 
fakture čija je šifra jednaka 1. Zapamtiti upit kao Query1. 
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Eliminisanje istih vrsta 
Da bi se videlo iz kojih gradova su firme sa kojima se posluje potrebno je prikazati iz 
tabele Firme polje Mesto. 
SELECT Mesto FROM Firme 
Međutim, ako se pogleda rezultat videće se da se gradovi ponavljaju. Da bi se eliminisale 
iste vrste u upitu, tj. da bi se prikazale samo međusobno različite vrednosti koristi se 
komanda DISTINCT. Ovo mora da se uradi u SQL prikazu: 
SELECT DISTINCT Mesto FROM Firme 

Kreiranje obrazaca za unos podataka 
Forme ili obrasci se koriste radi jednostavnijeg unosa, ažuriranja i pregledanja podataka u 
tabelama. 

Kreiranje obrasca korišćenjem čarobnjaka 
Postupak kreiranja obrasca uz pomoć čarobnjaka biće pokazan na primeru kreiranja 
obrasca za tabelu Proizvodi u bazi podataka Poslovanje. 

 Otvoriti bazu Poslovanje ako nije otvorena  
 Iz liste objekata izabrati kategoriju Forms 
 U prozoru baze kliknuti dvaput brzo levim tasterom miša na Create form by using 

wizard 
 Iz Tables/Queries padajuće liste izabrati tabelu Proizvodi 
 Izabrati polja koja će biti na obrascu tako što se izabere polje u prozoru Available 

Fields i klikne na dugme sa jednostrukom strelicom usmerenom u desno (>) da bi to 
polje prešlo u prozor Selected Fields. Ukoliko se želi da se sva polja prebace u 
prozor Selected Fields kliknuti na dugme sa dvostrukom strelicom usmerenom u 
desno (>>). Ukoliko je napravljena greška i želi se da se vrate neka polja treba 
iskoristiti dugme sa jednom (<) ili dve strelice usmerene u levo (<<). 

 Pošto su odabrana odgovarajuća polja pritisnuti na dugme Next 
 

 
 

 Na sledećoj strani se bira izgled obrasca i biće izabrano Columnar. Postoje 4 
različita prikaza obrasca: 

Columnar - prikazuje se jedan zapis na obrascu. Prikazuju se nazivi polja i polja u koja se 
unose podaci jedno pored drugog i to u kolonoma  
Tabular - prikazuje se više zapisa na obrascu i to polja u kolonoma i zapisi u redovima. 
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Datasheet - prikazuje obrazac identičan kao Datasheet prikaz tabele 
Justified - prikazuje se jedan zapis na obrascu, a nazivi polja su iznad polja u koja se 
unose podaci 

 

 
 

 Klikom na dugme Next prelazi se na sledeći korak 
 Na ovom prozoru se bira vizuelni stil obrasca i biće izabran stil Industrial 

 

 
 

 U poslednjem prozoru se daje naziv obrascu. Opcija Open the form to view or enter 
information ostaje selektovana (opcija Modify the form's design služi za prelazak u 
Design prikaz novokreiranog obrasca radi dorade) 
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 Nakon pritiska na dugme Finish otvara se novokreirani obrazac 
 

 

Podešavanje svojstava obrasca 
Kao i sa tabelama i sa obrascima je moguće raditi u različitim prikazima. Dva najčešća su 
prikaz Form, koji se koristi za pregled, ažuriranje ili unos podataka i prikaz Design koji se 
koristi za dodavanje kontrola obrascu ili menjanje svojstava ili izgleda obrasca.  
Kada se koristi čarobnjak Form da bi se napravio obrazac u formatu kolone, svako polje 
koje se izabere iz tabele nad kojom je napravljen obrazac predstavljeno je kontrolom polje 
za tekst i pridruženom kontrolom labela. Ovakav obrazac, koji se koristi za unos, 
ažuriranje ili pregled informacija u određenu tabelu, povezan je sa tom tabelom. Svako 
polje za tekst povezano je sa određenim poljem u tabeli. Tabela je izvor zapisa, a polje 
izvor kontrole. Svaka kontrola ima više svojstava, kao što su tip slova, veličina slova, 
poravnanje, boja ispune i ivice. Čarobnjak dodeljuje podrazumevane vrednosti svim 
svojstvima, ali ih je moguće promeniti da bi se poboljšao izgled obrasca.  

 Otvoriti bazu podataka Poslovanje  
 Odabrati Forms na traci Objects, izabrati obrazac Proizvodi i pritisnuti dugme 

Design (  ) na paleti alatki prozora baze podataka 
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 Pritisnuti na desni taster miša bilo gde u praznom prostoru Design prikaza i iz 
padajućeg menija izabrati Properties (svojstva). 

 Pojaviće se prozor koji će prikazati svojstva obrasca (ovaj prozor se može dobiti i 
pritiskom na taster F4). Izborom bilo kog objekta biće prikazana svojstva tog 
objekta. 

 Promeniti tip slova labele Ime na sledeći način: izbrati labelu i u padajućoj listi za 
Font Name (nalazi se na karici Format ili na kartici All), izabrati umesto postavljenog 
tipa slova Arial novi MS Sans Serif . Takođe je moguće promeniti i veličinu slova 
(Font Size). 

Sve opcije koje su dostupne u okviru za dijalog Properties dostupne su i na paleti alatki.  
U okviru za dijalog Properties moguće je prikazati grupisana svojstva biranjem 
odgovarajuće kartice: Format, Data, Event ili Other. Ili, mogu se prikazati sva svojstva 
biranjem kartice All.  
Ukoliko se želi da se promeni isto svojstvo za više kontrola potrebno je selektovati te 
kontrole i izvršiti promenu u okviru za dijalog Properties 

 Pritisnuti Ctrl+A da bi bile izabrane sve kontrole u odeljku Detail obrasca.  
Sve kontrole na obrascu mogu se izabrati i ako se u meniju Edit izabere Select All, ili 
razvlačenjem pravougaonika preko svih njih.  
 

 
 

Mali, crni markeri pojavljuju se oko svih kontrola što ukazuje da su one izabrane. Prozor za 
dijalog Properties ima naslov Multiple selection. Prikazana su samo svojstva iz grupe 
Format koja imaju iste vrednosti za sve izabrane kontrole.  

 Pritisnuti u polje Back Color, a zatim pritisnuti dugme ... desno od okvira da bi se 
pojavio okvir za dijalog Color:  
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 Izabrati sivu boju i pritisnuti dugme OK.  
 Postaviti vrednost polja Special Effect na Shadowed (senka). Senka će dobiti boju 

koja je podešena za svojstvo Border Color.  
 Klikom u odeljak Detail kontrole više neće biti selektovane i forma bi sada trebalo 

da izgleda ovako: 
 

 
 

 Kliknuti na dugme Save ( ) da bi se sačuvao izmenjeni obrazac 

Podešavanje prikaza obrasca  
Obrasci koje pravi čarobnjak su funkcionalni, ali nisu elegantni. Moguće je, međutim, 
prilično jednostavno prilagoditi prikaz da bi zadovoljio potrebe korisnika. Mogu da se 
dodaju i obrišu labele, pomeraju i labele i kontrole za tekst po obrascu, dodaju logoi i drugi 
grafički elementi i da se na druge načine poboljšava prikaz obrasca da bi bio atraktivan i 
jednostavan za korišćenje.  
Dok se radi sa prikazom obrasca, važno je da se obrati pažnja na oblik pokazivača koji se 
menja da bi ukazao na način na koji može da se menja izabrana kontrola. S obzirom da se 
polje za tekst i odgovarajuća labela ponekad ponašaju kao jedno, treba biti pažljiv i obratiti 
pažnju na oblik pokazivača pre nego što se izvrše bilo kakve izmene. U tabeli koja sledi 
objašnjeno je na koju radnju svaki od oblika upućuje:  
 
Oblik Radnja 
Šaka  Povući da bi se pomerile obe kontrole zajedno, kao jedna 
Kažiprst  Povući da bi se pomerila samo jedna kontrola 
Vertikalne strelice  Povući gornju ili donju ivicu da bi se promenila visina  
Horizontalne strelice  Povući desnu ili levu ivicu da bi se promenila širina 
Dijagonalne strelice  Povući ugao da bi se promenile i visina i širina 
 
U ovoj vežbi biće napravljen novi raspored kontrola (labela i polja za tekst) na obrascu 
Proizvodi. Uraditi sledeće:  

 Otvoriti bazu podataka Poslovanje 
 Otvoriti obrazac Proizvodi u prikazu Design 
 Ako je potrebno, povlačiti donji desni ugao prozora Form nadole i udesno dok se ne 

bude video Form Footer (podnožje obrasca) na dnu obrasca  
Obrazac je podeljen na tri odeljka: Form Header (zaglavlje obrasca), Detail i FormFooter. 
Trenutno, samo odeljak Detail nešto sadrži.  

 Dovesti pokazivač miša iznad desne ivice pozadine Detail i kada se pokazivač 
promeni u dvosmernu strelicu, povlačiti ivicu pozadine udesno dok se ne dostigne 
13 cm na horizontalnom lenjiru 

 Promeniti tekst u labeli za naziv proizvoda iz Ime u Naziv; takođe promeniti 
Jed_mere u Jedinica mere i Maticni_broj u Matični broj. 

 Smanjiti labelu Naziv i postaviti par kontrola za jedinicu mere pored naziva 
proizvoda da bi se dobio obrazac kao na slici: 
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Kada se napravi obrazac moguće je zapamtiti njegov stil i koristiti ga kasnije za ostale 
obrasce. 

 U meniju Format, pritisnuti AutoFormat da bi se pojavio okvir za dijalog AutoFormat:  
 

 
 

Pritisnuti dugme Costumize da bi se prikazao okvir za dijalog Costumize AutoFormat. 
 

 
 

 Izabrati Create a new AutoFormat based on the Form 'Proizvodi' i zatim pritisnuti 
dugme OK 

 U okviru za dijalog New Style Name, upisati Proizvodi kao naziv novog stila i zatim 
pritisnuti dugme OK. Sada se u bazi AutoFormat, novi stil pojavljuje u listi Form 
AutoFormat. 

Od sada, ovaj stil će biti na raspolaganju u svakoj bazi podataka koja će biti otvorena ili 
kreirana na istom računaru. 

 Pritisnuti OK da bi se zatvorio okvir za dijalog AutoFormat 
 Pritisnuti dugme Save (  ) 

Unos podataka korišćenjem obrasca 
Da bi se podaci uneli u tabelu korišćenjem obrasca, potrebno je najpre otvoriti taj obrazac. 

 Otvoriti obrazac Proizvodi. Kursor je automatski pozicioniran na prvo polje u 
obrascu. Pritiskom na taster Tab na tastaturi se vrši pomeranje iz polja u polje i 
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takođe se na taj način i kreira novi zapis ako se pritisne taster Tab posle poslednjeg 
polja poslednjeg zapisa. 

Novi zapis se takođe može kreirati pritiskom na dugme New Record ( ) na dnu prozora 
obrasca. Zapisi se automatski pamte tako da nije potrebna nijedna dodatna radnja. 

 Uneti podatke za nekoliko proizvoda po želji 
Samostalna vežba. Kreirati obrazac za unos podataka za tabelu Firme. Korišćenjem 
obrasca uneti podatke o nekoliko firmi. 

Kreiranje jednostavnih izvešataja 
Izvešataji organizuju i grupišu podatke iz tabela ili upita i omogućavaju da se ti podaci 
odštampaju. 
Za brzo dobijanje osnovnog izgleda izveštaja može da se upotrebi čarobnjak Report, ali je 
naknadno moguće koristiti prikaz Design za doterivanje izveštaja i dodavanje posebnih 
detalja. Doterivanje izveštaja je iterativni postupak, kod koga se stalno vrši prelazak iz 
prikaza Design u prikaz Print Preview i obrnuto da bi se procenila svaka izmena koja je 
napravljena i isplanirala sledeća izmena. Na sreću, prikaz Design za izveštaje je vrlo sličan 
prikazu Design za obrasce tako da bi ovo okruženje trebalo da bude prilično poznato.  

Kreiranje izveštaja korišćenjem čarobnjaka 
 Otvoriti bazu Poslovanje ako nije otvorena 
 Iz liste objekata izabrati Reports 
 U prozoru baze podataka kliknuti dvaput brzo levim tasterom miša na Create report by 

using wizard 
 Sada treba izabrati izvor informacija, odnosno tabelu ili upit na osnovu kojih će se 

praviti izveštaj, iz Tables/Queries padajuće liste. Izabrati tabelu Proizvodi. 
 

 
 

 Potom se izaberu polja koja će se prikazivati na izveštaju, tako što se iz okvira 
Available Fields prebace u okvir Selected Fields korišćenjem jednostruke (>) ili 
dvostruke (>>) strelice usmerene u desno. Kliknuti na dugme Next  da bi se prešlo na 
naredni korak. 
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 U ovom prozoru se mogu izabrati polja po kojima se želi vršiti grupisanje podataka. 
Nakon izbora polja klikom na strelicu usmerenu u desno (>) se ta polja dodaju u 
dijagram. Dugme Priority se može koristiti da se promeni prioritet, odnosno redosled, 
polja po kojima se vrši grupisanje. Kliknuti na dugme Next  da bi se prešlo na sledeći 
korak. 

 

 
 

Ako je potrebno da se izvrši sortiranje po jednom ili više polja u ovom prozoru se definiše 
po kojim poljima će se vršiti sortiranje i da li će biti sortirana po rastućem ili opadajućem 
redosledu. 

 Izvršiće se sortiranje po polju Ime. Potrebno je izabrati to polje iz padajuće liste i potom 
kliknuti na dugme Ascending/Descending da bi se definisalo da li se želi sortiranje po 
rastućem ili opadajućem redosledu. Kliknuti na dugme Next da bi se prešlo na sledeći 
korak. 
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 Na ovoj strani se biraju izgled izveštaja i orjentacija strane. Biće izabran izgled Tabular 
i Portrait orjentacija. Kliknuti na dugme Next. 

  

 
 

 Ovde se selektuje vizuelni stil izveštaja. Nakon izbora (izabran je stil Bold) treba kliknuti 
na dugme Next. 

 

 
 

Na poslednjem prozoru izveštaju se daje naziv i potom se otvara ili u Print Preview prikazu 
ili u Design prikazu (treba izabrati jednu od dve ponuđene opcije). Zadržati unapred 
izabranu opciju (Preview the report) i unapred ponuđeni naziv izveštaja (Proizvodi). 



 27

 Kliknuti na dugme Finish da bi se kreirao izveštaj 
 

 
 

Nakon pregledanja zatvoriti izveštaj. 
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Podešavanje prikaza izveštaja 
Doterivanje izveštaja je iterativni postupak u kome se vrši prelazak iz prikaza Design u 
Print Preview prikaz i obrnuto da bi se procenila svaka izmena koja je napravljena i 
isplanirala sledeća izmena. Prikaz Design za izveštaje je vrlo sličan prikazu Design za 
obrasce.  
U ovoj vežbi će se malo promeniti izgled izveštaja Proizvodi iz baze podataka Poslovanje.  

 Otvoriti bazu podataka Poslovanje 
 Na traci Objects, izabrati Reports 
 Izabrati izveštaj Proizvodi i zatim pritisnuti dugme Preview ( ) da bi se otvorio 

izveštaj u prikazu Print Preview kao na slici: 
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 Da bi se promenili neki detalji, pritisnuti strelicu usmerenu na dole desno od dugmeta 
View (  ) i izabrati Design View, da bi se prešlo u Design prikaz izveštaja gde on 
izgleda kao na slici koja sledi:  

 

 
 

 Promeniti naslov izveštaja u Abecedni spisak proizvoda 
 Promeniti nazive zaglavlja kolona: Ime u Naziv, Maticni_broj u Matični broj i Jed_mere 

u Jedinica mere 
Promeniti prikaz datuma.  

 Kliknuti na polje u kome piše Now(), potom otvoriti okvir za dijalog Properties, potom 
karticu Data. U polju Control Source piše = Now(); umesto toga upisati 
=Format(Now();"dd-mm-yyyy"), što znači da će biti prikazan trenutni datum u formatu 
dve cifre za dan, dve cifre za mesec i četiri cifre za godinu. 

 Na isti način promeniti u donjem desnom delu izveštaja prikaz broja strane.    ="Page " 
& [Page] & " of  " & [Pages] je tekst koji se trenutno nalazi u Control Source svojstvu.  
="Page " je tekst koji se vidi i njega treba promeniti u "Strana ", [Page] je funcija koja 
određuje redni broj tekuće strane, a [Pages] je funkcija koja kao rezultat vraća ukupan 
broj strana. Te dve komponente izraza ostaju nepromenjene. " of  " treba promeniti u    
" od ". 

Izgled izveštaja bi trebalo da bude kao na sledećoj slici: 
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Štampanje izveštaja 
Izabrati File→Page Setup da bi se podesile margine, veličina i orjentacija papira. Posle 
podešavanja kliknuti na File→Print iz menija ili na dugme Print na paleti alatki. 


